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MOJO/
REQUIREMENTS
AND
INSTALLATION

SYSTEM REQUIREMENTS
For Mac users, MOJO requires OS 10.4.x or greater, a G4 1.4GHz
or Intel Core Duo 1.66GHz or faster, a DVD drive, and 2GB of RAM.
For Windows users, MOJO requires Windows XP or Windows
Vista or greater, a Pentium or Athlon 1.4GHz or faster, a DVD
drive, and 2GB of RAM.
The library requires 15GB of disk space.
Vir2 Instruments strongly recommends 4GB RAM or more and an
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88-key controller in order to use MOJO to its fullest potential.

INSTALLING

UPDATING & AUTHORIZING

The installation of MOJO is two separate steps: the installation of

After installation, please make sure that you are fully updated to

the Kontakt engine, and the installation of the MOJO library.

the most recent versions of the three components that make up
the MOJO package: the library (which contains all the patch infor-

Insert the installation disc into your computer, and you will see

mation and programming), the engine (which is powered by

the installers for both components. It doesn’t matter which is in-

Kontakt), and the authorizer (Service Center). It is possible that

stalled first. Run each of the installers and they will guide you

any of these components may have a more recent version than

through the installation process.

shipped in your physical package, so you should check for updates
to each of these three. You can do this by visiting the vir2.com

The Kontakt installer will install the Kontakt engine, its standalone

web site and checking the Support area.

application, all of its plug-in versions, and the Service Center authorizer program. We recommend the Easy Install and that the

After you’ve completed installation, MOJO will be working in demo

install locations for each component are left at their default

mode, meaning it will only work for 30 minutes at a time. To fully

settings.

authorize it, launch Service Center (found in the Applications folder
on a Mac, or the Program Files folder on Windows) and follow its

The MOJO library is approximate 14GB in size, and its installer will

instructions. You will be prompted to enter your e-mail address

prompt you for the location you wish to install it. It can be installed

and password that make up your Native Instruments account, or

on any available hard drive. For speed reasons, we recommend it

will be given an option to create an account if you don’t already

be installed on internal or eSATA drives. Firewire can also be ac-

have one. Once inside the Service Center, it will give you a list of

ceptable. External USB drives may give somewhat less optimized

all the Native Instruments and NI-powered products on your hard

performance. We also recommend 7200 or 10,000rpm drives re-

drive and give you the option to activate them. You are allowed to

gardless of the interface used.

install and use MOJO on up to two computers simultaneously.
Service Center will guide you through the process for either online
(instant) activation, or offline activation.
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MOJO/
INTRODUCTION
TO
THE
LIBRARY

Now at the tips of your fingers is the most
versatile horn section in the world, MOJO:
Horn Section, offering the most flexible
and innovative approach to pop, funk,
jazz, and big band horns ever created in a
virtual instrument. Inspired by legendary
groups like Tower of Power and the big
bands of decades past, MOJO is capable
of emulating everything from a sultry sax
solo to a screaming full big band playing
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at the top of their lungs.
Pushing the boundaries of sampling and scripting technology far
beyond traditional sample libraries, MOJO offers a simple but feature-packed interface. No need to decide in advance which
articulation you want to play. Simply load the instrument, turn the
Ensemble knob to specify how many players you want playing
that instrument (from a soloist to a dectet) and begin controlling
RIght: Screenshot of Mojo’s Interface

the instrument from the keyboard.

More than a dozen articulations are instantly loaded and intelli-

The articulation list varies for each instrument, but generally in-

gently handled via performance features and keyswitches. Behind

cludes sustains, stabs, staccatos, trills, slurs, shakes, octave runs,

the scenes, a humanizing function, smart release layers, and cus-

rise to hits, falls (including four different lengths), doits, bends,

tom legato and vibrato tools assist the player in reproducing the

stylistic riffs, special effects, and tempo-synced swells and cre-

ultimate dimensions in realism. Crescendos and swells sync in-

scendos. All samples are recorded in 24-bit stereo using the finest

stantly to host tempos and can be triggered in real time. Included

preamps in the world, including a vintage Neve 1073 and a

in the instrument collection are: soprano, alto, tenor, and baritone

LaChapell Audio 992EG, and mics by AKG, Neumann, and Coles.

saxophones, trumpet (open, muted, and piccolo), flugelhorn,
trombone (open and muted), bass trombone, and clarinet.

The Ensemble Knobs
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MOJO/
USING
KONTAKT

HOW TO ACCESS THE MOJO LIBRARY FROM KONTAKT
MOJO ships as a Kontakt-powered library, and MOJO is opened
from within Kontakt, which can be run either as a standalone application, or as a plug-in hosted by any major sequencer on either
Macintosh or Windows platforms. All these versions are installed
by the Easy Install option of the installer.
Users who don’t own a sequencer, or would like to simply boot up
and be able to play MOJO, can go to their Applications folder
(Mac) or Program Files folder (Windows) to launch Native
Instruments > Kontakt.
Users who wish to use MOJO for sequencing or recording, or wish
to play it multitimbrally, should use it in plug-in mode within a
host sequencer. Kontakt supports the VST, AudioUnit, and RTAS
plug-in formats. Any host sequencer that supports these plug-in
formats properly will be able to use Kontakt. Instructions vary
slightly from sequencer to sequencer, but the general procedure
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is to instantiate Kontakt as a virtual instrument plug-in, then load
a MOJO instrument in Kontakt, then route a MIDI track to Kontakt
so it can be triggered and recorded.
The following instructions will help standalone and plug-in users
get up and running quickly with a basic track of MOJO.

USING KONTAKT IN STANDALONE MODE

latency slider, the less latency (the split second between the physical playing of the note and the sound coming out of Kontakt) will

The standalone Kontakt application can be found in the

be, but the harder the computer will have to work. Typical useful

Applications > Kontakt 3 folder for Mac users, or Program Files >

values range between 128 and 256, however very fast computers

Native Instruments > Kontakt 3 for Windows users.

may be able to handle lower values, while very slow computers
may need higher values. > [IMAGE 01]

After launching the Kontakt application for the first time, you will
be presented with a dialog box to set up your audio and MIDI set-

The MIDI page of the Options dialog box must be configured in

tings. Settings will vary for each user according to the specific

order to let Kontakt know which MIDI device(s) to respond to.

setup, but the important thing is to route the audio to a valid au-

Kontakt will respond to up to four MIDI input ports (A, B, C, and

dio device, and to set the buffer reasonably low for good latency

D), so we recommend you switch one MIDI source on to Port A,

performance. We recommend 256 samples or less. The lower the

as shown in the graphic below. > [02]

01

02

07

08

01

More detailed information on the setup options can be found in
the accompanying Kontakt manual. Once you have completed
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Kontakt setup, jump ahead to the Getting Started with MOJO
section below.

USING KONTAKT AS A VST PLUG-IN IN CUBASE AND NUENDO
Users of Steinberg’s Cubase or Nuendo sequencers can use
Kontakt as a VST plug-in. These instructions have been prepared
in Cubase 5, although Kontakt may also work in earlier versions if
the computer meets the system requirements. Once the project is
02

open, go to the Devices menu and choose VST Instruments > [01]
When the VST Instruments window appears, click in the first
available slot in which “no instrument” is listed. > [02]
A popup menu will appear; choose Kontakt 3. Then, an alert box
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will appear asking if you want to create a MIDI track assigned to
03

the Kontakt 3 plug-in. Click Create. > [03]
The Kontakt window will appear, and a MIDI track will be created,
transmitting to Kontakt’s MIDI channel A-1. When it is record-enabled, it will send any incoming MIDI played on your controller
into Kontakt. At this point, you can skip down in the instructions
to the Getting Started With MOJO section below.

USING KONTAKT AS AN AUDIOUNIT PLUG-IN IN LOGIC PRO,

09

04

LOGIC STUDIO, LOGIC EXPRESS, ETC.
Users of Apple’s Logic can use Kontakt as an AudioUnit plug-in.
These instructions have been prepared in Logic Pro 8, although
Kontakt may also work in earlier versions if the computer meets
the system requirements.

05

Once inside your Logic project, go to the Track mini-menu (in the
central area of your screen) and choose Track > New... > [04]
The New Tracks dialog box will appear. Make sure Soft-ware

The new instrument track will be created. On the left side of the
screen you will see the channel strip for that channel, including a
fader, pan knob, and various insert slots. Locate the blank slot
just below the letters “I/O” and above the output pair: > [06]

07

Click there, and a list of plug-ins will appear. Choose AU
Instruments > Native Instruments > Kontakt 3 > Stereo. > [07]
06

The Kontakt window will appear, and a MIDI track will be created,
transmitting to Kontakt’s MIDI channel A-1. When it is record-enabled, it will send any incoming MIDI played on your controller
into Kontakt. At this point, you can skip down in the instructions
to the Getting Started With MOJO section below.
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Instrument is selected, then click Create. > [05]
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USING KONTAKT IN GARAGEBAND

CHAPTER 02 / USING KONTAKT

01

Users of Apple’s GarageBand can use Kontakt as an AudioUnit
plug-in. These instructions have been prepared in GarageBand 5
02

(which shipped with iLife ‘09), although Kontakt may also work in
earlier versions if the computer meets the system requirements.
Once inside your GarageBand project, go to the Track menu and
choose New Track. > [01]
A window with three choices will appear. Choose Software
Instrument, then click Choose. > [02]

03

On the right side of the interface, the Browse tab will be showing.
Switch to the Edit tab. > [03]
The Sound Generator will default to Piano. Click Piano, and a pop-
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up menu will appear. Choose Audio Unit Modules > Kontakt 3. > [04]

04

Note: GarageBand may default to inserting effects, such as a compressor and a visual EQ on this track. This will color the sound. If
you don’t want these effects used, you can remove them.
Once Kontakt 3 is selected, the icon will change to the AudioUnit
icon (the ball with the sound waves radiating outward). Double-

05

click on the icon to bring up the Kontakt window. > [05]

11

The Kontakt window will appear, and a MIDI track will be created,
transmitting to Kontakt’s MIDI channel A-1. When it is record-enabled, it will send any incoming MIDI played on your controller

06

into Kontakt. At this point, you can skip down in the instructions
to the Getting Started With MOJO section below.

USING KONTAKT AS AN RTAS PLUG-IN IN PRO TOOLS

07

Users of Digidesign’s Pro Tools (M-Powered, LE, or TDM) can use
Kontakt as an RTAS plug-in. These instructions have been prepared in Pro Tools 8, although Kontakt may also work in earlier
versions if the computer meets the system requirements. Once
the project is open, go to the Track menu and choose New... > [06]
In the dialog box that appears, choose the appropriate options,
such as the following: create 1 new stereo Instrument Track in
samples. Then click Create. > [07]
09

Go to the Mix window and look at the channel strip for the instrument. At the very top is an area for Inserts A-E. Shown in > [08]
Click on the first of the five slots, and navigate through the popup
menu to choose multichannel plug-in > Instrument > Kontakt 3.
Shown in image > [09]

08
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The Kontakt window will appear. At this point, you can skip down

USING KONTAKT AS A VST OR AUDIOUNIT PLUG-IN IN

in the instructions to the Getting Started With MOJO section.

ABLETON LIVE
Users of Ableton Live can use Kontakt as a VST or Audio-Unit
plug-in, depending on the version. The functionality is the same.

USING KONTAKT AS AN AUDIOUNIT PLUG-IN IN DIGITAL

These instructions have been prepared in Live 7, although Kontakt

PERFORMER

may also work in earlier or later versions if the computer meets
the system requirements.

Users of MOTU’s Digital Performer can use Kontakt as an AudioUnit
plug-in. These instructions have been prepared in Digital Performer

Once the project is open, go to the left side and click on the third

6, although Kontakt may also work in earlier versions if the com-

icon down to show the Plug-in Devices list, scroll to the Native

puter meets the needed system requirements.

Instruments folder and locate Kontakt 3: > [03]

Once the project is open, go to the Project menu and choose Add

Drag Kontakt 3 into the central area where the text “Drop Files

Track > Add Instruments... > [01]

and Devices Here” is shown.

In the resulting dialog box, click on the Unassigned pulldown menu,

The Kontakt interface will appear, and it will already be actively

and choose Native Instruments > Kontakt 3. You can also change

transmitting to Kontakt’s MIDI channel A-1. When it is record-en-

the number of MIDI tracks to be added, if you know you will want

abled, it will send any incoming MIDI played on your controller

to use more than one. > [02]

into Kontakt. At this point, you can skip down in the instructions
to the Getting Started With MOJO section below.

The Kontakt window will appear, and a MIDI track will be created,
transmitting to Kontakt’s MIDI channel A-1. When it is record-enabled, it will send any incoming MIDI played on your controller
into Kontakt. At this point, you can skip down in the instructions
to the Getting Started With MOJO section below.
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USING KONTAKT AS A PLUG-IN IN ANOTHER HOST
01

There are too many host programs to cover here in detail, but any
modern sequencer that properly supports the VST, AudioUnit, or
RTAS standards should be able to use Kontakt properly, and load
MOJO within it. Consult the manual for your specific host to find
out how to instantiate the Kontakt virtual instrument.

03
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USING
THE
CORE
INSTRUMENTS

GETTING STARTED WITH MOJO
Once you’ve followed the instructions above to get Kontakt loaded
in whichever mode you prefer, Kontakt’s inner workings are exactly the same. On the left side of the Kontakt interface is a sidebar
called the Browser, and it has six tabs across the top: Files,
Libraries, Database, Monitor, Modules, and Auto. Click the Library
tab to get started with MOJO. > [01]
The MOJO library will appear, with buttons to access Instruments,
Multis, and other materials. Clicking on the Multis or Instruments
button will reveal folders of loadable patches, which will be discussed in more detail below.

USING MOJO: THE CORE INSTRUMENTS
Let’s jump right in. MOJO is simultaneously designed to be very
MOJO / HORN SECTION

easy to use, and yet be almost infinitely tweakable. To accomplish
this, much of its power is hidden below its surface. MOJO is built
around the twelve core instruments, mentioned above. When any
of the instruments are loaded, the interface looks like this, giving
you access to the most central features, including displays to show
you the currently active behaviors, and menus that lead to submenus revealing more of MOJO’s power: The two visible knobs
RIght: Screenshot of Mojo’s Interface

are called Players and Mode, and each will be discussed separately.

Players. MOJO is designed so that loading any instrument gives

The Players Knob can be controlled via external MIDI CC as well.

you instant access to both solo and section versions of that in-

This makes it easy, for example, to sequence a MIDI part featuring

strument. The Players knob can be adjusted from Solo (1 player)

stacked trumpet section ensemble lines, then switch to a solo

to up to 10 players. As you add players to the ensemble, MOJO

trumpet for a solo part, then back to the ensemble. Since this is

employs a large number of techniques to create the ensemble.

controlled via MIDI CC, the instructions to alter the number of

It spaces the players in the ensemble across the stereo field, tells

people in the section (and indeed, every parameter about the

them how in-tune (or out of tune) to play, and how much varia-

section’s behavior) can be written into the MIDI track, insuring

tion there should be within the ensemble. (All of these parameters

perfect recall every time the sequence is played. The external

can be adjusted and will be discussed later, in the Section menu.)

MIDI CC which controls the players knob is CC#22. > [02]

02

04

03

05

01
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Mode. The Mode knob is a central knob to how each instrument

is triggered via a silent trigger key called a keyswitch. Keyswitches

operates. It has three settings: > [03 PREVIOUS PAGE]

will be discussed later in this manual. This display is placed here
as an aid to show you which articulation is currently active.

Poly stands for polyphonic playing, meaning that multiple notes
can be played simultaneously. MOJO has a very high polyphony

The Active Release display shows which release articulation is cur-

limit, so if your computer has enough power, it can play a large

rently in use. A release articulation is a sample that is triggered

number of notes simultaneously. Adding players via the Players

when a key is released (instead of the Active Articulation which is

knob also contributes to higher polyphony.

the articulation that is triggered when a key is pressed). MOJO
features regular release layers (the sound of the player naturally

Mono stands for monophonic playing. When in this mode, the

stopping the note with their lips) as well as custom release layers

instrument will only play one note at a time. If you play a single

such as falls of varying lengths, or slurs, and so on. Like Active

note on your keyboard, then hold it while you strike a second

Articulations, the various available release layers can be triggered

note, the first original note will stop playing, and only the second

via silent trigger keys called keyswitches. The display always

note will be heard.

shows you the currently active release layer.

Legato is similar to Mono in that only one note can be played at a
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time, however, when Legato mode is used, MOJO intelligently connects the first note to the second, simulating a true legato style.

SETUP MENU

Display Areas. Below the Players and Mode knobs lie two dark

The Setup menu contains several subpages of detailed control

areas which are used to display various important pieces of infor-

panels which can be used to modify the sound and behaviors

mation about what is being played. > [04 PREVIOUS PAGE]

of MOJO. > [05 PREVIOUS PAGE]

The Active Articulation display shows which articulation is currently in use. Available articulations vary from instrument to
instrument, but generally include: sustains, staccatos, stabs,
swells, crescendos, bends, runs, trills, and so on. Each articulation

01

Vibrato. This page allows you to customize the behavior of the

The Mode Menu lets you select between Mode 1 and Mode 2.

physically modeled vibrato, which is applied by moving the mod

Mode 1 uses less granular stretching and is better for more play-

wheel (MIDI CC#1). When the mod wheel is at its minimum posi-

ers, while Mode 2 uses more stretching but results in a fuller

tion, no vibrato is added. As you move the mod wheel up, a

sound, and is better for less players.

modeled vibrato is applied to the dry sound. > [01]
The Players Pulldown Menu reflects the number of players seThe Menu (shown as “All-Purpose”) allows you to choose the char-

lected by the Players knob. It also dictates the default number of

acter of vibrato to use. Note that each vibrato type only takes

players if the section is turned on via the keyswitch.

effect after raising the mod wheel (or CC#1); simply choosing the
preset will not immediately cause any change to the sound. > [02]

The S Spread Knob allows you to adjust the position of the players in the stereo field. A higher percentage means that players will

The Vibrato Knob shows how much vibrato is being applied at the

be spread apart widely.

moment. It moves in real time to reflect the mod wheel or CC#1.
The S Depth Knob allows you to increase a random amount of
The V Speed Knob allows you to specify the speed of the vibrato.

timing difference between the players. Higher values will make

It defaults to a standardized speed that is universally useful, but

the players play slightly less together.

slower speeds may offer better results for ballads, while faster
speeds may offer better results for uptempo songs or quick playing.
Section. The Section page allows you to customize the characteristics of the section. The settings on this page only affect the
instruments when the Players knob is set to more than 1 player.
Once there are two or more players in the ensemble, the Section
parameters take effect and alter the way the section behaves.
Section page shown in image > [03]
02

03
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The S Detune Knob allows you to increase a random amount that

The Humanize Button governs an advanced series of behaviors

players will be detuned from each other. Higher values will make

that prevent the engine from using the same sample twice in a row,

the players play less in tune with each other.

thus eliminating the infamous “machine gun” effect so common
to older methods. The engine often uses adjacent samples as well

The S Human(ize) Knob allows you to increase a random amount

as alternate takes and velocity layers to render as realistic a per-

of velocity randomization.

formance as possible. It can be defeated by disabling this button.

Each of the knobs in the Section page have been preset to all-

The H Range Knob dictates how widely the Humanize engine

purpose values that work well for most situations.

may pull an adjacent sample from, and can be set from 1-4.
Setting this knob higher will result in more randomness but a

Instrument. The Instrument page gives you several controls over

greater risk for an odd-sounding sample that might be pitch-

the overall sound and behavior of the instrument. > [01]

stretched from too far an interval.

The menu that defaults to Alternate A/B specifies how the engine

The H Seed Knob gives the Humanize engine a virtually random

uses or orders the alternate samples. Almost every sample in

start value, from 1000 to 5000.

MOJO has been recorded with multiple takes (A and B) which are
an integral part of its realism. Using this menu, samples can alter-

Legato. MOJO includes an extremely advanced legato engine de-

nate between A and B takes, or reverse (B and A), or only A, or

signed to facilitate realistic smooth legato playing. By default,

only B. In general, the greatest realism is achieved with A/B or B/A.

MOJO is configured with parameters that result in an all-purpose
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optimum legato right out of the box, and is used anytime the
The Character Menu gives seven choices between a standard

Mode knob is set to Legato. These settings are normally enough

character, and different shades of aggressive or mellow playing.

for most legato applications. > [02]

The Punch Knob adds additional attack to the beginning of each

For users who wish to manipulate the legato behavior in greater

sample. More rhythmic playing may benefit from added punch,

depth, we will explain the design here.

and attacks will sound crisper if this knob is turned up.
MOJO’s legato is actually three different legato modes which are

19

switched between according to certain criteria. In the screenshot
above, each of the three legato mode’s characteristics can be altered. X-Time controls crossfade time (the time in which two
legato notes are crossfaded), and B-Time controls bend time (the

01

time in which a pitch warp or glide from one legato note to the
next takes place).
With the three Edit Legato Buttons, you can access more detailed
behaviors for the three legato modes: adjusting the quality (lower
quality results in lower CPU usage), and the parameters related to
the pitch-bending of legato notes. If you select “cent” you can en-

02

ter how many cents the last note is bent towards the new note,
and the new note will start with a small pitch offset closer to the
old note, then it subtly bends towards its true pitch. > [03]
The Octave Factor multiplies this cent value according to the
played interval, in other words, if you play an octave interval and
you set the octave factor to 5, the pitch warp is five times stronger. You can also select the interval settings which use the played
interval to calculate the pitch warp, or use the glide settings

03

which result in a full glide from each legato note to the next. Glide
Up and Glide Down limit glides to only up- or only down-glides.
With Legato Rules > [04] you can tell the engine when each legato
mode is used or not used. By default, legato mode 1 is triggered
by slower playing (time differences of 500ms or more from one
note to the next, and an interval of less than two half-steps), while

04
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legato modes 2 and 3 are triggered by progressively faster playing.

note, triggered when a MIDI key is released. The release layers

The combination of these factors allows MOJO to respond dynami-

contribute greatly to the realism of the instruments. The Releases

cally to different styles of playing and produce realistic smooth

page allows you control over how the release layers behave.

legato renderings. Each legato mode can by bypassed in the
Legato Rules page, in case you need to only use one legato, or if

The Mode knob lets you choose between Mode 1, which only trig-

you prefer to use MIDI CC control to alter one legato in real time.

gers releases if no other key is pressed anymore, and Mode 2,
which plays all release notes (except in Legato mode, in which

Pitchbend. The Pitchbend page controls how the pitch bend

case releases are not played within a legato phrase to facilitate

wheel behaves. When it is selected, a pulldown menu and a knob

proper smooth legato rendering.

appear:
The Volume Knob allows you to adjust the level of the release
The Mode Knob allows you to select between Mode 1 for standard

samples. In each instrument, this has already been preset to an

pitch bend (which is the default) and Mode 2 which employs a

appropriate level for the instrument.

more advanced formant-correcting algorithm for pitch bend
(which only works in Solo or Legato mode). Formant-correct pitch

Speed. The Speed menu governs the behavior of both swells and

bend uses more CPU and polyphony, but results in more realistic

crescendo articulations for each instrument. Swells and crescen-

pitch bend. Mode 2 is particularly effective on the instruments

dos were recorded at two different lengths (long and short) for

that can naturally slide between pitches, like the Trombone and

every instrument in MOJO, and have been specially designed to

Bass Trombone.

tempo-sync automatically. The engine will read the tempo that

MOJO / HORN SECTION

the host is playing at (and will even follow changing tempos), and
The P Range Knob lets you set the maximum range of the pitch

will calculate the proper length for the swell. The Speed menu al-

bend sweep (both above and below the source pitch). In Mode 1,

lows you to preset the desired lengths of swells and crescendos

the maximum is 12 half steps or semitones. In Mode 2, the maxi-

in beats.

mum is 7 half steps or semitones.
Four pulldown menus appear, allowing long crescendos and
Releases. MOJO includes extensive and intelligent release layers,

swells to be set from 2 beats to 18 beats, and short crescnedos

which are samples of the sound of the instrument stopping a

and swells to be set from 1 beat to 9 beats.

There is some overlap between the ranges of the short and long

Dry And Wet Knobs allow you to adjust the balance of the dry

articulations. For example, it is possible to set long crescendos to

(unaffected) and wet (reverb) sound to taste.

last 4 beats and short crescendos to also last 4 beats. MOJO will
utilize a different set of samples for each, and will time-stretch the

The Equalizer is a 3-band equalizer and offers control over the

crescendos to fit the current tempo. Different tempos may result

frequency, bandwidth, and gain of each band.

in better results using one method or the other.
The Compressor takes the incoming audio signal, and attenuates
any signal that crosses the threshold (which can be adjusted using the Threshold knob) by the ratio (which can be adjusted using
EFFECTS TAB

the Ratio knob). In plain English, the Compressor makes loud signals a little softer, so that the dynamic range of the instrument is

The Effects tab provides access to nine built-in audio effects that

more limited, and therefore more listenable and more likely to sit

can be applied to any MOJO instrument.

in a mix well. In addition, once the Compressor limits the dynamic
range, the overall level of the instrument can now be boosted (us-

Each effect features an Active button that must be clicked (en-

ing the Output knob). Attack and Release knobs are also provided,

abled) before it will process the audio.

which specify how fast the Compressor attenuates the signal and
how long it takes for the Compressor to stop attenuating the sig-

EZRoom. EZRoom is an easy-to-use integrated convolution re-

nal after the signal goes below the threshold.

verb included with MOJO, and provides a quick way to instantly
place the horns into a new acoustic space.

Saturation is an effect that adds density (saturation) to the
sound. It has only one knob, Saturation. Raising this knob will

The Ezroom Menu allows you to choose which impulse response

make the sound thicker and fuller and somewhat louder.

to use. A large number of impulse responses have been provided
as part of the library.

Distortion adds overdriven, amp-style distortion to the sound.
This is useful more as a special effect. Controls are provided for

The Predelay Knob lets you specify a predelay time for the con-

Drive (overall level of added distortion) and Damping (a dulling

volution in milliseconds.

of the high frequencies as distortion is added).
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Chorus adds a thickening effect by doubling the signal and de-

OTHER PATCHES

MOJO / HORN SECTION

CHAPTER 03 / USING THE CORE INSTRUMENTS

tuning the copy. Controls are provided for Depth, Speed, and
Phase.

Core Instruments Lite. These instruments function identically
with their Core Instruments counterparts, except they use a frac-

Reverb adds natural room echo to the sound. It is different from

tion of the number of samples of the full version. As a result, the

EZRoom, which is a convolution reverb based on actual real sonic

playing and the humanizing will be less detailed, however, users

spaces. Controls are provided for Predelay, Size, Color, Damping,

who have limited amounts of RAM will be able to load more at

Pan (Stereo Width), and Return Volume.

once by using these Lite versions.

Delay adds a time-based delay to the sound, and can be fed back

Ensembles. This folder offers various combinations of MOJO in-

into itself by engaging the Feedback parameter. Controls are pro-

struments, for example, Alto Sax, Tenor Sax, Trumpet, and

vided for Delay Time (in milliseconds), Feedback, Damping, Pan

Trombone all layered over each other. Only sustain and release ar-

(Stereo Width), & Return Volume.

ticulations are included in these instruments, making them ideal
for quickly building large-sounding horn sections. Note that, due

Stereo allows you to control the overall stereo character of the in-

to the varying range of each instrument, different areas of the

strument. The Spread knob allows for the increasing or decreasing

keyboard feature different overlaps between the instruments,

of the stereo width, and the Pan knob allows for the overall pan-

with the extreme low and high notes sometimes covered by only

ning of the instrument.

one of the included instruments.

The Limiter is a brick-wall limiter, which is enabled by default. It at-

Riffs feature almost two thousand prerecorded riffs played across

tenuates any signal that exceeds the maximum 0dB level. In Gain,

each of the instruments. They have been grouped by instrument,

Release, and Output controls are also provided. Turning the

tempo, and key.

Output knob above 0dB will result in distortion.
Within each patch are anywhere from a few to dozens of riffs.
Riffs are always mapped chromatically, starting at C2 (the C below middle C). The interface in the Riffs instruments is different
than the Core Instrument. > [01]

The Effects menu is available and works identically to the Core

sustains and releases. They are much faster to load than the Core

Instruments, but there is a Key knob allowing for the easy trans-

Instruments and use less RAM. They are useful for instances in

position of the riffs into other keys. The Key knob defaults to the

which realism is less important than being able to simply orches-

key of the patch loaded (C Major in this example), and a pulldown

trate horn parts.

menu allows the choice of two different transposition methods.
All riffs automatically sync to host or MasterKontrol tempo. This
particular instrument, while recorded at 120bpm, will play back
at whatever tempo the host sequencer or the Kontakt Master
Kontrol is set to.
Note that both time-stretching (syncing) and transposing are done
by Kontakt’s DSP, and they work best if the distance to stretch is
smaller rather than larger. This example patch, which was recorded
in C major at 120bpm, should sound fine if played back in C# major
at 110bpm, but may sound strange if stretched to F# major and
50bpm. The best rule of thumb is to try and use riffs patches that
are as close as to the key and tempo that you need them to be.
Special Effects encompass various noises that the instruments
can make, such as key clicks, unusual glissandi, and more. Several
hundred samples are included across the instruments, and each
loadable patch features the individual samples mapped chromatically on the keyboard starting at C1 (two octaves below middle C).
Sustains Only contain the same twelve instruments as the Core
Instruments, but remove all additional articulations apart from

01
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MOJO/
TIPS
ON
EFFECTIVE
SEQUENCING

MOJO is an extremely complicated instrument, and without proper
management, using it in a sequencing environment can be daunting. What follows is a list of tips that can make the use of MOJO
much smoother.
TIP 01: At the beginning of each MIDI track that is triggering MOJO,
write in the starting articulation keyswitch (e.g. sustain), the Players
knob setting (solo or 2-10 players), and the Mode (poly, mono, or
legato). This insures that every time you rewind your sequence to
the beginning, the MOJO instrument will reset itself to the same
starting point. The location of these keyswitches is different for
each instrument in MOJO, therefore, you will save time by initially
writing these “reset” commands at the beginning of the sequence
so that MOJO can be reset at any time.
TIP 02: If you would like to sequence multiple solo lines of the
same instrument (for example, four alto sax parts all playing legato), you can load up four instances of the Alto Sax instrument.
This is useful if you require fluid legato playing for each of the

MOJO / HORN SECTION

four voices. Because all four instances are using the same set of
core samples, the same amount of RAM is used whether you are
running four Alto Sax instances or one.

TIP 03: Combining the previous two tips, if you have multiple in-

TIP 06: If you are using a release articulation (e.g. a fall) following

stances of the same instrument, you can insert the reset com-

a staccato or stab articulation, note that the fall will trigger when

mands for one instance, then copy and paste to the other three.

the note is released, not when the sound of the staccato or stab
finishes. Therefore, it’s crucial to adjust the location of the note-

TIP 04: If you are writing large ensemble horns (e.g. big band

off message (the end of the MIDI note) to coincide with where the

style), you can get more realistic acoustic results by narrowing

fall should begin.

the stereo field of the individual instruments (Setup > Section >
S Spread and S Depth, and/or Effects > Stereo > Spread), then

TIP 07: If you are sequencing fast big band music and need sloppy

panning the overall instrument to a specific location in the stereo

doubling, try loading multiple versions of each instrument, then

field. If you don’t apply this technique, then all instruments will

try setting each instance to different articulations, such as sustain,

appear to be located everywhere in the stereo field, which makes

bend down, stab, and staccato. While the stab and staccato artic-

for a nice fat sound but is not the way a true ensemble would

ulations will be very short, the sustain and bend down articulations

sound unless recorded from a great distance. Experiment with

will provide the sustain, and the end result will be four players

stereo placement to get the results you want.

playing in very different styles.

TIP 05: When sequencing very short notes, experiment not just

TIP 08: Sections will often benefit from a constantly added very

with staccato and stab articulations, but also with sustain and

slight amount of vibrato. Since the vibrato is applied per player, it

bend down articulations played very short. The playing style is

will add another human factor to the section.

very different for each. Sustains and bend downs played short tend
to be more pitched and fit well in a section, while staccatos and
stabs tend to have more bite, aggressiveness, and are the exclamation mark of the articulations. Try each of these articulations to
find the best fit for the passage of music being worked on.
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C0
C#0

Section
Legato

B6
A#6
D6
C#6
A6
G#6
C6
G6
F#6
F6
E6
D#6
B5
F5
G#5
G5
A5

Sustain
Bend Down
Run Octave Down
Run Octave Up
Stab
Staccato
Doit
Trill
Swell Short
Swell Long
Cresc. Short
Cresc. Long
Overblown
Overblown Vibrato
Sub Tone
Rise To Hit
Slur Up
Shakes
‘Pow’

D0
D#0

Regular
Doit

Articulation /

Release

C7

Sustain Vibrato

Articulation /

B-1

Mono

BARI SAX
A#1

D#0

D0

A5

-

-

-

-

-

-

D#6

E6

F6

F#6

G6

C6

G#6

A6

-

-

A#6

B6

-

C#0

C0

B-1

A#1

A-1

BASS TROMBONE

A-1

D#0

D0

A5

-

-

-

-

-

-

D#6

E6

F6

F#6

G6

C6

G#6

A6

-

-

A#6

B6

-

C#0

C0

B-1

A#1

A-1

TROMBONE
MUTE

Solo

D#0

D0

A5

-

G5

-

-

-

-

D#6

E6

F6

F#6

G6

C6

G#6

A6

-

-

A#6

B6

-

C#0

C0

B-1

A#1

A-1

TROMBONE

Poly

Play Mode /
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F0
F#0
G0
G#0
A0
A#0
C1

Fall Medium
Fall Long
Fall Extra Long
Trill
None
Slur Up
Shakes

G#4

Maximum

G#4

C#2

C1

A#0

A0

G#0

G0

F#0

F0

E0

G#4

C#2

C1

A#0

A0

G#0

G0

F#0

F0

E0

G#4

C#2

C1

A#0

A0

G#0

G0

F#0

F0

E0

which may or may not be available in certain instruments.

The only way in which they differ is with some of the extra articulations

and trombone mute) share a very similar keyswitch articulation layout.

All of the bass/lower instruments (bari sax, bass trombone, trombone,

so it is less necessary to constantly refer to this manual.

ful guide; it will show each keyswitch pressed and indicate its function,

exist for each instrument. Note that the onscreen display is also a help-

This guide will specify what keyswitches and available playing ranges

instrument to instrument since the range of each instrument varies.

ticulation or behavior. The location of the keyswitches varies from

make a sound but instead instruct the engine to activate a specific ar-

Each instrument includes silent triggers called keyswitches which don’t

upper end of the keyboard.

the lower end of the keyboard while the piccolo trumpet will be at the

ing range. In other words, this means that a bass trombone will be at

Each instrument has been mapped on the keyboard at its actual sound-

KEYMAPPING, ARTICULATIONS, AND KEYSWITCHES

C#2

Minimum

Play Range /

E0

Fall Short
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C0
C#0

Section
Legato

B6
A#6
D6
C#6
A6
G#6
C6
G6
F#6
F6
E6
D#6
B5
A#5
F5
A5

Sustain
Bend Down
Run Octave Down
Run Octave Up
Stab
Staccato
Doit
Trill
Swell Short
Swell Long
Cresc. Short
Cresc. Long
Overblown
Overblown Vibrato
Sub Tone
Rise To Hit
Slur Up
Shakes
‘Pow’

D0
D#0

Regular
Doit

Articulation /

Release

C7

Sustain Vibrato

Articulation /

B-1

ALTO SAX
D#0

D0

A5

-

-

G#5

-

-

-

D#6

E6

F6

F#6

G6

C6

G#6

A6

C#6

D6

A#6

B6

-

C#0

C0

B-1

D#0

D0

A5

-

-

G#5

-

-

-

D#6

E6

F6

F#6

G6

C6

G#6

A6

C#6

D6

A#6

B6

-

C#0

C0

B-1

A#1

A-1

FLUGELHORN

A#1

D#0

D0

A5

-

-

G#5

-

-

-

D#6

E6

F6

F#6

G6

C6

G#6

A6

C#6

D6

A#6

B6

-

C#0

C0

B-1

A#1

A-1

PICCOLO
TRUMPET

Mono

CLARINET
A-1

D#0

D0

A5

-

-

G#5

-

-

-

D#6

E6

F6

F#6

G6

C6

G#6

A6

C#6

D6

A#6

B6

C7

C#0

C0

B-1

A#1

A-1

SOPRANO SAX

A#1

D#0

D0

A5

-

G5

G#5

F5

A#5

B5

D#6

E6

F6

F#6

G6

C6

G#6

A6

C#6

D6

A#6

B6

C7

C#0

C0

B-1

A#1

A-1

TENOR SAX

A-1

D#0

D0

A5

F#5

-

G#5

-

-

-

D#6

E6

F6

F#6

G6

C6

G#6

A6

C#6

D6

A#6

B6

-

C#0

C0

B-1

A#1

A-1

TRUMPET MUTE

Solo

D#0

D0

A5

F#5

-

G#5

-

-

-

D#6

E6

F6

F#6

G6

C6

G#6

A6

C#6

D6

A#6

B6

-

C#0

C0

B-1

A#1

A-1

TRUMPET

Poly

Play Mode /
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F0
F#0
G0
G#0
A0
-

Fall Medium
Fall Long
Fall Extra Long
Trill
None
Slur Up
Shakes

G#4

Maximum

G#4

C#2

-

-

A0

G#0

G0

F#0

F0

E0

G#4

C#2

-

A#0

A0

G#0

G0

F#0

F0

E0

G#4

C#2

-

A#0

A0

G#0

G0

F#0

F0

E0

G#4

C#2

-

-

A0

G#0

G0

F#0

F0

E0

G#4

C#2

-

-

A0

G#0

G0

F#0

F0

E0

G#4

C#2

C1

A#0

A0

G#0

G0

F#0

F0

E0

G#4

C#2

C1

A#0

A0

G#0

G0

F#0

F0

E0

01

Customized keyswitch menu > [01 ]

down the list, and a quick MIDI Learn button to reassign any keyswitch.

able in the current instrument, along with the ability to scroll up and

clicking on the Keyswitch tab, which shows a list of keyswitches avail-

Users who want to customize the keyswitch arrangement can do so by

a very similar keyswitch articulation layout:

pet, soprano sax, tenor sax, trumpet, and muted trumpet) likewise share

All of the other instruments (alto sax, clarinet, flugelhorn, piccolo trum-

C#2

Minimum

Play Range /

E0

Fall Short
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089 On / Off
090 Output Gain
091 Drive
092 Damping

039 Legato1 XTime
040 Legato1 BTime
041 Legato1 Dynamic
042 Legato1 Quality

064 Character

Stereo Modeler /

110 Feedback

064 Sustain Pedal
028 Pitch Mode (S/FC)

109 Pan

063 Humanize Range
027 Section Humanize

065 Sample Set

108 Damping

062 Humanize
026 Section Detune

Pitch Bend /

107 Time

Miscellaneous /
025 Section Depth

106 Return Gain

105 On / Off

061 Legato3 Octave
024 Section Mode

Delay /
060 Legato3 Cent

104 Stereo

023 Section Stereo Spread

103 Damping
058 Legato3 Quality
022 Section Players

102 Colour
057 Legato3 Dynamic
021 Vibrato Speed

059 Legato3 Type

101 Size
056 Legato3 BTime
020 Vibrato Character

Sectioning /

100 Pre Delay
055 Legato3 XTime
001 Vibrato Strength

099 Return Gain

053 Legato2 Cent
054 Legato2 Octave

098 On / Off

052 Legato2 Type
011: Expression (SV)
Vibrato /

Reverb /
051 Legato2 Quality

010: Pan

096 Speed

048 Legato2 XTime

097 Phase

095 Depth

047 Legato2 TurnOff

050 Legato2 Dynamic

094 Return Gain

046 Legato1 TurnOff

007: Volume

093 On / Off

045 Legato1 Octave

049 Legato2 BTime

Chorus /
044 Legato1 Cent

043 Legato1 Type

Distortion /

Legato /

Global Parameters /

MOJO/
MIDI
CC
CHART
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076 High Bw
077 Low Gain
078 Mid Gain
079 High Gain

035 Swell Speed Long
036 Swell Speed Short
EZRoom /
037 EZRoom Wet Volume

118 Release

117 In Gain

116 Output Gain

114 Pan

113 Spread

KEY: SV = Secondary Volume / S = Standard / FC = Format Correct

Many parameter in MOJO’s various menus can be controlled remotely
via MIDI CC, and therefore can be easily automated in a sequencer. This
is a comprehensive list of the CC’s that MOJO responds to.

LOCATED ABOVE

088 Saturation

087 Output Gain

086 On / Off

Saturation /

085 Release

084 Attack

083 Ration

082 Thresh.

081 Output Gain

080 On / Off

Compressor /

075 Mid Bw

034 Crescendo Speed Short

038 EZRoom Dry Volume

074 Low Bw

072 Mid Freq
033 Crescendo Speed Long

115 On / Off

071 Low Freq

032 Release Volume
073 High Freq

070 On / Off

031 Release Mode

Tempo-Syncing /

Limiter /

Equalizer /

Releases /

112 Output Gain

068 Punch Mode

030 Pitch Range (FC)

011 On / Off

067 Punch

029 Pitch Range (S)

>
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TECH SUPPORT
Vir2 Instruments stands behind its products and is committed to
helping you get the most out of using them. Please check the
Support area of the www.vir2.com web site if you encounter any
difficulties in using the product. You may also e-mail support@
vir2.com.
Before getting in touch with Vir2 Instruments regarding problems
with the product, make sure you are running the latest versions of
the library, engine, and Service Center. We are continuously updating and improving the product, so it is possible that there are
more recent updates available that were released after the physical manufacturing of your installation disc.

THE FULL VERSION OF KONTAKT 3

MOJO / HORN SECTION

MOJO ships with Kontakt 3 running in library mode, meaning it is
fully able to play back the MOJO library and access the parameters detailed in this manual.
Registered owners of MOJO are eligible for a special crossgrade
discount to the full version of Kontakt 3, which enables users to
create their own libraries, import libraries in non-Kontakt formats,

and access numerous deep editing features. Visit the nativeinstruments.com web site for details on the Kontakt crossgrade.

LICENSE AGREEMENT
The samples contained herein are licensed, not sold to you, the individual end user, by Vir2 Instruments. This non-exclusive,
non-transferable license is granted only to the individual end user
who has purchased an unopened, new, and lawfully made copy of
this product from a dealer or distributor authorized by Vir2
Instruments. All samples remain the property of Vir2 Instruments
and are licensed only for use in the creation of a live or recorded
performance that includes the licensed samples as part of a derivative musical work created by the licensed end user. This
license expressly forbids resale, rental, loan, gift, or transfer of
these samples in any format or via any medium, except as part of
a derivative musical work. The samples may not be included,
whether unmodified or as part of a derivative work, in any sample
library product. Any unlicensed usage will be prosecuted to the
maximum extent possible under the law.
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